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Chapter 826

Tests of Mediation
Effect in Poisson
Regression
Introduction
This procedure computes power and sample size for a test of the mediation effect in a Poisson regression with a
dependent (output) variable Y of counts and an independent (input) variable X. Interest focuses on the
interrelationship between Y, X, and a third independent variable called the mediator M. The sample size
calculations are based on the work of Vittinghoff, Sen, and McCulloch (2009). Note that their work has been
extended in Vittinghoff and Neilands (2015). We are looking into adding those extensions in a later procedure.

Mediation Model
Vittinghoff, Sen, and McCulloch (2009) derived sample size formulas for testing the mediation effect based on
testing the significance of 𝛽𝛽𝑀𝑀 in the Poisson regression model
𝑃𝑃

log(1−𝑃𝑃) = 𝛽𝛽0 + 𝛽𝛽𝑋𝑋 𝑋𝑋 + 𝛽𝛽𝑀𝑀 𝑀𝑀.

They showed that testing 𝛽𝛽𝑀𝑀 = 0 is equivalent to testing for a significant mediation effect. In addition to the
notation above, they use 𝜌𝜌𝑋𝑋𝑋𝑋 as the correlation between the independent variables X and M and E(Y) to represent
the marginal mean of Y.

Calculating the Power
Power calculations are based on the following assuming that if X is continuous, the variance of X is 𝜎𝜎𝑋𝑋2 , or, if
binary, the variance of X is 𝑝𝑝𝑋𝑋 (1 − 𝑝𝑝𝑋𝑋 ) where 𝑝𝑝𝑋𝑋 = Prob(𝑋𝑋 = 1). Similar notation is used for the mediator
variable M.

1. Determine the critical value 𝑧𝑧1−𝛼𝛼 from the standard normal distribution where α is the probability of a
type-I error.

2 2
2
𝛽𝛽𝑀𝑀 (1 − 𝜌𝜌𝑋𝑋𝑋𝑋
)𝐸𝐸(𝑌𝑌) − 𝑧𝑧1−𝛼𝛼 .
2. a. If X is continuous and M continuous, use 𝑧𝑧𝛽𝛽 = �𝑁𝑁𝑁𝑁𝑀𝑀
2 2
2
𝛽𝛽𝑀𝑀 (1 − 𝜌𝜌𝑋𝑋𝑋𝑋
)𝐸𝐸(𝑌𝑌) − 𝑧𝑧1−𝛼𝛼 .
b. If X is binary and M continuous, use 𝑧𝑧𝛽𝛽 = �𝑁𝑁𝑁𝑁𝑀𝑀
2 (1
2 )𝐸𝐸(𝑌𝑌)𝐹𝐹1
− 𝑧𝑧1−𝛼𝛼 .
c. If X is continuous and M binary, use 𝑧𝑧𝛽𝛽 = �𝑁𝑁𝛽𝛽𝑀𝑀
− 𝜌𝜌𝑋𝑋𝑋𝑋
2 (1
2 )𝐸𝐸(𝑌𝑌)𝐹𝐹2
− 𝑧𝑧1−𝛼𝛼 .
d. If X is binary and M binary, use 𝑧𝑧𝛽𝛽 = �𝑁𝑁𝛽𝛽𝑀𝑀
− 𝜌𝜌𝑋𝑋𝑋𝑋
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where
2 ]/[(𝐺𝐺
2
𝐹𝐹1 = [𝐺𝐺𝐺𝐺𝜎𝜎𝑋𝑋.𝑀𝑀
+ 𝐺𝐺𝐺𝐺(𝜇𝜇1 − 𝜇𝜇0 )2 ]
+ 𝐻𝐻)2 𝜎𝜎𝑋𝑋.𝑀𝑀
𝑝𝑝

𝜇𝜇0 = −𝜌𝜌𝑋𝑋𝑋𝑋 𝜎𝜎𝑋𝑋 � 𝑀𝑀 when 𝑀𝑀 = 0
1−𝑝𝑝
1−𝑝𝑝𝑀𝑀
𝑝𝑝𝑀𝑀

𝜇𝜇1 = 𝜌𝜌𝑋𝑋𝑋𝑋 𝜎𝜎𝑋𝑋 �

𝑀𝑀

when 𝑀𝑀 = 1

2
2 )
𝜎𝜎𝑋𝑋.𝑀𝑀
= 𝜎𝜎𝑋𝑋2 (1 − 𝜌𝜌𝑋𝑋𝑋𝑋

𝐺𝐺 = 𝑝𝑝𝑀𝑀 exp(𝛽𝛽𝑋𝑋 𝜇𝜇1 + 𝛽𝛽𝑀𝑀 )

𝐻𝐻 = (1 − 𝑝𝑝𝑀𝑀 )exp(𝛽𝛽𝑋𝑋 𝜇𝜇0 )

𝐹𝐹2 = [𝐵𝐵𝐵𝐵𝐵𝐵 + 𝐵𝐵𝐵𝐵𝐵𝐵 + 𝐵𝐵𝐵𝐵𝐵𝐵 + 𝐶𝐶𝐶𝐶𝐶𝐶]/[(𝐵𝐵 + 𝐶𝐶 + 𝐷𝐷 + 𝐸𝐸)(𝐵𝐵 + 𝐷𝐷)(𝐶𝐶 + 𝐸𝐸)]

𝐵𝐵 = 𝑝𝑝00

𝐶𝐶 = 𝑝𝑝10 exp(𝛽𝛽𝑋𝑋 )

𝐷𝐷 = 𝑝𝑝01 exp(𝛽𝛽𝑀𝑀 )

𝐸𝐸 = 𝑝𝑝11 exp(𝛽𝛽𝑋𝑋 + 𝛽𝛽𝑀𝑀 )

𝑝𝑝

𝑝𝑝11 = 𝑝𝑝𝑋𝑋 𝑝𝑝𝑀𝑀 + 𝜌𝜌𝑋𝑋𝑋𝑋 �𝑝𝑝𝑋𝑋 (1 − 𝑝𝑝𝑋𝑋 )𝑝𝑝𝑀𝑀 (1 − 𝑝𝑝𝑀𝑀 ) with 𝜌𝜌𝑋𝑋𝑋𝑋 |0 < 𝑝𝑝11 < 𝑝𝑝𝑋𝑋𝑀𝑀
𝑝𝑝10 = 𝑝𝑝𝑋𝑋 − 𝑝𝑝11

𝑝𝑝01 = 𝑝𝑝𝑀𝑀 − 𝑝𝑝11

𝑝𝑝00 = 1 − 𝑝𝑝01 − 𝑝𝑝10 − 𝑝𝑝11

3. Calculate: Power = Φ(𝑧𝑧𝛽𝛽 ).

Notes

𝛼𝛼
2

1. Use instead of 𝛼𝛼 for two-sided test.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. Under most situations, you will
select either Power or N (Sample Size).
Select Sample Size when you want to calculate the sample size needed to achieve a given power and alpha level.
Select Power when you want to calculate the power of an experiment.
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Test Direction
Alternative Hypothesis
Specify whether the hypothesis test is one-sided or two-sided. When a two-sided test is selected, the value of
alpha is automatically divided by two. A two-sided test requires alpha to be less than 0.50.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error (alpha). A type-I error occurs when
you reject the null hypothesis when in fact it is true.
Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means
that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that
represents the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
N (Sample Size)
This option specifies the value(s) for N, the sample size. Note that 3 < N.

Effect Size
βᴍ (Reg Coef of M)
Enter one or more values for βᴍ which is the coefficient of M in the Poisson regression model
log(Y) = β0 + βx(X) + βᴍ(M)
Y is the count (response), X is the primary predictor variable, and M is the mediator variable.
Range
βᴍ can be any value other than zero.
ρxᴍ (Correlation of X and M)
Enter one or more values for the correlation of X and M.
Range
0 < ρxᴍ < 1.
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Data Types of X and M
Specify the data types (continuous or binary) of independent variables X and M.
X is the primary predictor variable.
M is the mediator variable.
Note
Here, 'Continuous' refers to data that are normally distributed.
σX (Standard Deviation of X)
Enter one or more values for the standard deviation of X, the primary predictor variable.
Range
0 < σM.
σM (Standard Deviation of M)
Enter one or more values for the standard deviation of X, the primary predictor variable.
Range
0 < σM.
Probability X = 1
Enter one or more values of the probability in the population that X = 1 when X is a binary variable that takes on
the values 0 or 1. This value is used to compute the variance of X using the formula: σX² = P(X=1) × (1 - P(X=1)).
Range
Since this is a probability, it can be any value between 0 and 1.
Probability M = 1
Enter one or more values of the probability in the population that M = 1 when M is a binary variable that takes on
the values 0 or 1. This value is used to compute the variance of M using the formula: σM² = P(M=1) × (1 P(M=1)).
Range
Since this is a probability, it can be any value between 0 and 1.
E(Y) (Marginal Mean of Y)
Enter one or more values for the marginal mean of Y, where Y is the count variable. Y cannot be zero since the
model uses log(Y).
Range
0 < E(Y).
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Example 1 – Finding Sample Size
Researchers are studying the relationship between a count-type dependent variable (Y) and a continuous
independent variable (X). They want to understand the impact of a continuous third variable (M) on the
relationship between X and Y, so they decide to carry out a mediation analysis. They decide to determine the
sample size based on the significance test of the mediator term in a Poisson regression. Using prior analyses, they
decide to use βᴍ = 0.3, 0.4, 0.5, ρxᴍ = 0.4, σᴍ = 1, and E(Y) = 0.5 0.8. They set the power at 0.9 and the twosided significance level at 0.05.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests of Mediation Effect in Poisson Regression procedure. You may then make the
appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example
Template.
Option

Value

Design Tab
Solve For ................................................ N (Sample Size)
Alternative Hypothesis ............................ Two-Sided
Power ...................................................... 0.90
Alpha ....................................................... 0.05
Data Types of X and M ........................... X = Continuous, M = Continuous
βᴍ (Reg Coef of M)................................. 0.3 0.4 0.5
ρxᴍ (Correlation of X and M) .................. 0.4
σᴍ (Standard Deviation of M) ................. 1
E(Y) (Marginal Mean of Y) ...................... 0.5 0.8

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results ────────────────────────────────────────────────────────────
Data Types: X is continuous and M is continuous
Two-sided alternative hypothesis

Power
0.9000
0.9004
0.9012
0.9008
0.9026
0.9021

Sample
Size
N
278
174
157
98
101
63

Reg
Coef
of M
βᴍ
0.300
0.300
0.400
0.400
0.500
0.500

Corr
of X
and M
ρxᴍ
0.400
0.400
0.400
0.400
0.400
0.400

Std
Dev
of M
σᴍ
1.00
1.00
1.00
1.00
1.00
1.00

Marg
Mean
of Y
E(Y)
0.50
0.80
0.50
0.80
0.50
0.80

Alpha
0.050
0.050
0.050
0.050
0.050
0.050

References
Vittinghoff, E., Sen, S., and McCulloch, C.E. 2009. 'Sample size calculations for evaluating mediation.'
Statistics in Medicine, Vol. 28, Pages 541-557.
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Report Definitions
Hypotheses: H0: βᴍ = 0 versus H1: βᴍ ≠ 0. (Two-Sided).
X is the primary predictor. It is a continuous variable.
M is the mediator. It is a continuous variable.
Model: log(Y) = β0 + βx(X) + βᴍ(M).
Power is the probability of rejecting a false null hypothesis.
N is the number of observations on which the multiple regression is computed.
βᴍ is the regression coefficient of the mediator in the model.
ρxᴍ is the correlation between X and M.
σᴍ is the standard deviation of M.
E(Y) is the marginal mean of the outcome, Y.
Alpha is the probability of rejecting a true null hypothesis. It should be small.
Summary Statements ─────────────────────────────────────────────────────────
A sample size of 278 achieves 90% power to detect a mediation effect (as measured by the
regression coefficient of M, βᴍ) of at least 0.300 when the two-sided significance level
(alpha) is 0.050. The correlation between X (the primary predictor) and M (mediator) is 0.400.
The medicator, M, has a standard deviation of 1.00. The marginal mean of the outcome, E(Y), is
0.50.

This report shows the necessary sample sizes. The definitions of each of the columns is given in the Report
Definitions section.

Plots Section

These plots show the relationship between sample size and the regression coefficient.
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Example 2 – Validation using Vittinghoff (2009)
Vittinghoff et al. (2009) present an example on page 546 in which βX = log 1.4 (0.3365), βM = log 1.35 (0.3001),
ρxᴍ = 0.5, σX = 1, P(M=1) = 0.25, and E(Y) = 0.5. They set the power at 0.8 and the one-sided significance level
at 0.025. The computed sample size is 1037.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests of Mediation Effect in Poisson Regression procedure. You may then make the
appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example
Template.
Option

Value

Design Tab
Solve For ................................................ N (Sample Size)
Alternative Hypothesis ............................ One-Sided
Power ...................................................... 0.80
Alpha ....................................................... 0.025
Data Types of X and M ........................... X = Continuous, M = Binary
βx (Reg Coef of X) .................................. 0.3365
βᴍ (Reg Coef of M)................................. 0.3001
ρxᴍ (Correlation of X and M) .................. 0.5
σx (Standard Deviation of X) .................. 1
Probability M = 1 ..................................... 0.25
E(Y) (Marginal Mean of Y) ...................... 0.5

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results ────────────────────────────────────────────────────────────
Data Types: X is continuous and M is binary
One-sided alternative hypothesis

Power
0.8001

Sample
Size
N
1037

Reg
Coef
of X
βx
0.337

Reg
Coef
of M
βᴍ
0.300

Corr
of X
and M
ρxᴍ
0.500

Std
Dev
of X
σx
1.00

Prob
M=1
P(M=1)
0.250

Marg
Mean
of Y
E(Y)
0.50

Alpha
0.025

PASS matches the calculation of N = 1037.
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